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Marine Reserves and Local Fisheries

An Interactive Simulation

Simulation Exercise

ABSTRACT

In tropical areas, such as the Caribbean, extraordinarily diverse marine ecosystems are found. People also live in these places, and harvest marine organisms for their livelihoods. The complex question arises: How to balance marine biodiversity conservation and local fishery activities? Marine protected areas are a promising means of jointly considering these factors.

This simulation-based exercise is an educational tool that allows users to:

1) Explore various factors that influence fish population viability and fishery sustainability; and 

2) Experiment with the use of marine reserves as tools in fisheries management.

This exercise allows users to explore issues related to marine reserves and local fisheries via interactive simulations.  Users are able to control:

(1) some attributes of a local fishery - including population dynamics and mobility of the target species as well as aspects of fisher behavior and economic factors,  and 

(2) the extent and placement of marine reserves.  

By exploring the contributions of these issues to fisheries productivity over time, users gain some understanding of the factors contributing to how reserves can interact with local fisheries.  

CAVEATS
Organismal populations and fishery economics in real life are affected by many more variables than any model can incorporate. The abundance and distribution of organisms, as well as related economic activity, are likely impacted by factors such as organismal life history complexities, ecological interactions, environmental quality, the frequency and severity of disturbance, and changing human use pressures. Furthermore, most of the model’s variables are in practice dynamic, variable, and non-independent. 
NOTES: Responses for all levels will vary, due to stochasticity and variation inherent in the program and responses. The “answers” give a general indication of expected results, however other responses are possible (for example given chosen reserve design).
· Environmental variation is not incorporated into the model. This can include changes in weather, climate change, catastrophes (such as hurricanes), pollution levels, etc. All of the factors used in the simulation vary from area to area, and the default values do not describe any specific real life scenario, or incorporate natural ranges. 

· Complexities in organismal life cycles are not fully addressed. There is incomplete knowledge of life-history traits and animal biology (competition, mortality, etc.). Sources of variation include gender or stage-specific biased dispersal, as well as variation over time and space of factors including: rates of total fish population recovery, habitat pressures, growth rates, migration patterns, susceptibility to fisheries, and carrying capacities. 

· Each of the factors in simulation may affect the different stages of life of an organism in a distinct way, as life stages may have different requirements. Organisms may take longer to recuperate from perturbations in certain life stages; initial populations may change or crash if they cannot recover from one cycle to the next. The model, for example, does not incorporate spawning aggregations, with their associated increased vulnerability to fishing pressure. Probably the most tricky and problematic in terms of "realism" is the Nassau grouper.  Although there are trap fisheries on the species year-round in many places, the vast majority of fishing on grouper populations-- where substantial populations still exist-- are on spawning aggregations during the winter months.  As one might imagine, exploiting breeding aggregations can be an especially effective way to catch and extirpate populations, and most knowledge of grouper abundance dynamics will likely be heavily influenced by those types of fishing impacts rather than the day-to-day, non-aggregated type simulated in the interactive.

· Carrying capacity (K) is not readily parameterized and defined; it is a descriptive measure useful for simple ecosystems. 

· Effects of ecological interactions, such as the population dynamics of ecologically associated species (predators and prey), are not included. In addition, levels of predation and competition may change, rather than remaining constant. 

· Economic and human factors, such as market pressure and enforcement issues, vary in the real world and affect fishing patterns. A fundamentally non-realistic aspect of the interactive is that it is a single-species fishery simulation.  By focusing exclusively on one species at a time, small-scale fishers drive down local populations (and their incomes) much faster than they would (and probably do in reality) if they could switch among target species as a function of prey abundance and expected returns or as a function of defined seasons for target species.

Local fisheries

There are several species worldwide that play key roles in their ecosystems. Some of these organisms also contribute significantly to the economic welfare of local fishers. In the Caribbean, three important such species are the Queen Conch (Strombus gigas), the Nassau Grouper (Epinephelus striatus), and the Spiny Lobster (Panulirus argus).  
Queen Conch 

The Caribbean Queen Conch fishery is one of the most important in the Caribbean, and the organism’s biology enhances its susceptibility to fishing pressure. Strombus gigas is a gastropod in the Strombidae family. This marine snail is found throughout the Caribbean, as well as in Bermuda, South Florida, Mexico, Venezuela and Brazil (FAO 1977). The species has declined throughout its range. Trade in Queen Conch is now restricted; it is listed on Appendix II of CITES (the Convention on International Trade of Endangered Species of Wild Fauna and Flora; CITES undated). S. gigas is also listed in Annex III of the Protocol  Concerning Specially Protected Areas and Wildlife to the Convention for the Protection and Development of the Marine  Environment of the Wider Caribbean Region (SPAW), so that use is regulated (UNEP undated). 

The Conch fishery in the Caribbean is worth millions of dollars each year. Harvest dates to prehistoric times, however high levels of commercial take are relatively recent. The meat can be served in salads or chowder, or as fritters, while shells are used to make jewelry and pottery. Fishing methods include capture by hand, use of simple gear such as forked poles, or even generally illegal SCUBA (Catarci 2004). These methods do not greatly negatively affect habitats or ecosystems, or other species through incidental by-catch (Cascorbi 2004). In some areas, like the Bahamas, conch is harvested during the lobster fishery closed season, or as part of a multiple species effort (Catarci 2004). Management is coordinated regionally by the International Queen Conch Initiative. The fishery is regulated through temporal or spatial closures, as well as size limits, gear restrictions, and catch quotas. Commercial and recreational fisheries in Florida, for example, are closed, however stocks have not recovered quickly. In many nations measures are not effective, due to factors such as illegal fishing or inadequate management (Cascorbi 20004). 

Aspects of this species biology contribute to its vulnerability to harvest (Gascoigne 2002; Cascorbi 2004). Queen conchs are long-lived, grow slowly, have delayed sexual reproduction, and their reproductive output increases with age (CHC CIC 2003). S. gigas live up to about 25 years, mature at around 3-5 years, and are relatively fecund. Reproduction occurs through internal fertilization, when large numbers of conch migrate to shallow waters for breeding. Fertilized eggs hatch after about 5 days into veligers, or larvae. These may drift with currents to settle in sands distant from their natal areas, where they metamorphose. The conch’s life history is characterized by high mortality at younger ages, however older individuals are naturally protected from predators by their strong shells. This species is, however, relatively easy for humans to capture. It lives in accessible shallow waters, is clearly visible, and moves slowly. S. gigas occur mainly in shallow sea grass beds linked to coral reefs, with the youngest found closest to shore. Queen conch forage on plankton as larvae, and algae, sea grass and other plants as adults (Ray and Stoner 1995; CHN CIC 2003). Vulnerability increases when conch aggregate in large numbers to spawn. This anthropogenic mortality of the later life stages, combined with habitat loss and pollution, are likely to be driving population declines. Further, reproduction in S. gigas may fail below certain density thresholds, inhibiting recovery (Stoner and Ray-Culp 2000). 
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Nassau Grouper
The endangered Nassau Grouper, Epinephelus striatus, is declining throughout its range. This species occurs in the tropical western Atlantic Ocean, including the Caribbean Sea and the Gulf of Mexico. E. striatus is found in Bermuda, the Bahamas, Florida, Central America and northern South America  (Sadovy and Eklund 1999). Currently, this member of the sea bass family (Serranidae) occupies only a fraction of its historical range, and is classified as Endangered according to the World Conservation Union  (IUCN 2004). Under this definition, endangered taxa are those that have suffered a high rate of population decline and are at risk of extinction. E. striatus has declined by about 60% over the last three generations (IUCN 2004). Historically, the grouper fishery has been one of the most important and valuable throughout its range (Sadovy and Eklund 1999; Gascoigne 2002).  Grouper is used in traditional dishes, such as boiled fish and grouper fingers. In the Bahamas, one of the few locations where stocks remain relatively abundant, Nassau Grouper is the most valuable finfish. Commercial landings there were valued at over BSD$ 2.7 million in 2003 (Fisheries Department, The Bahamas undated).  

Nassau grouper grow slowly and have delayed reproduction, reaching sexual maturity at about 4 yrs of age. These characteristics hinder population recovery from low densities, enhancing vulnerability to fishing. These groupers are long-lived, capable of surviving over 20 years in the wild, and have naturally low adult mortality (Sadovy 2002). Reproductive rate and number of eggs per reproductive event increase with age in this species. Fishing often targets larger individuals, eliminating those with highest reproductive capacity and skewing the age class distribution to juveniles with relatively low survivorship (Gascoigne 2002). Adults undergo breeding migrations to specific offshore areas where they form ephemeral spawning aggregations. These groups formed for reproductive and courtship purposes may number in the tens of thousands, and occur hundreds of kilometers from their resident habitat (Sadovy and Eklund 1999). Fish are readily caught during spawning, at which time fishery ease increases due to predictable occurrence of dense aggregations. Uncontrolled harvest of these has rendered many stocks commercially extinct, and disrupted spawning behavior (Gascoigne 2002). Inexperienced groupers are thought to be unable to locate their spawning site without the assistance of older fish. Thus, once eliminated, spawning aggregations tend to not form again, at least on ecological time scales (Coleman et al. 1999). 

Measures have been instituted to limit fisheries in response to the observed decline in grouper numbers. These include seasonal closures, some prohibiting fishing of spawning aggregations. In place also are gear restrictions and harvest limits for fish size and number. Commonly employed fishing methods include handline, traps and spear guns. Marine protected areas have been hailed as one of the most promising methods for protecting Nassau Grouper (Sadovy and Eklund 1999; Gascoigne 2002). Taxation based on vessel or harvesting characteristics is another possible alternative measure.   

Habitat use, diet, and ecological role vary throughout the grouper life cycle (Sadovy and Eklund 1999). Larvae hatch from pelagic eggs a day or two after fertilization. After about 30 – 50 days, small juveniles leave the pelagic, shifting to inshore nursery areas such as reefs, seagrass or algal beds. Larger juveniles move to shallow reefs at about 4-5 years of age and feed mainly on crustaceans. Adults recruit to deeper waters, where they establish residence in areas with rocky substrates, such as caves, crevices and cracks. Nassau grouper are among the larger reef fish, reaching 1-2 feet in length (Sadovy 2002). Most groupers change sexes with age, although this may not be the case for E. striatus. As adults, Nassau grouper rarely disperse from their territories, with the exception of the annual breeding migrations. A top predator whose diet includes crustaceans, reef fish, and octopus, E. striatus plays a key role in reef communities. Throughout the life cycle, this species serves as important prey for organisms such as reef shark, barracuda, dolphins, and man. E. striatus  have formed symbiotic relationships, visiting cleaning stations where small wrasse or shrimps remove parasites from inside their mouths. Thus, reductions in Nassau grouper populations impacts other organisms in their community.
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Spiny Lobster

The Spiny Lobster (Panulirus argus) is a migratory arthropod that occurs in tropical and subtropical marine ecosystems. This species can be found in the Western Atlantic Ocean, the Caribbean Sea and the Gulf of Mexico, ranging from North Carolina to Rio de Janeiro, Brazil (FAO 2004). These Palinurid crustaceans are known for their migratory behavior, which can involve single-file group movements of juveniles and adults from shallow to deeper waters, related to seasonal, severe weather, or other factors (Herrnkind et al. undated). Larvae often disperse across national territories, so that management in one country may affect populations in others. This arthropod is omnivorous, scavenging mainly nocturnally on diverse kinds of vegetable and animal matter, including crustaceans and gastropods (Briones-Fourzan et al. 2003; Bliss 1982). These lobsters in turn are prey for various organisms, including sharks, groupers, sea turtles, snappers, octopuses, and humans. 

Spiny lobsters, commonly known as Crawfish, are harvested throughout their range. This multi-million dollar fishery is one of the most valuable in the Caribbean (Cascorbi 2004; Bene and Tewfik 2001). Capture methods include free diving, use of traps, spears, and trawls (Bene and Tewfik 2001; FAO 2004). Spiny lobster fisheries in Florida and the Bahamas do not result in notable harm to habitats and ecosystems, and levels of by-catch are low (Cascorbi 2004). In some areas, such as the Turks and Caicos, Panulirus argus may be harvested jointly with the Queen Conch (Bene and Tewfik 2001). Caribbean spiny lobsters are not classified as endangered or threatened, although they are listed on the SPAW protocol (UNEP undated). Aspects of their biology, such as relatively low age at sexual maturity, medium maximum age, and high reproductive potential, may contribute to a relatively low inherent susceptibility to fishing pressure (Cascorbi 2004). The fishery is regulated, including measures such as closures during spawning season, trap-reduction programs, legal size and bag limits. Also illegal in some countries is harvesting of egg-bearing females, and fishing with firearms or explosives. Effectiveness of enforcement varies regionally (Cascorbi 2004). Marine reserves protect lobsters and their habitats, although very small protected areas are likely inadequate (Eggleston and Dahlgren 2001). 

Spiny lobsters occupy a variety of environments throughout their life cycle, which spans an approximate maximum of 30 years. Reproduction and fertilization occur in offshore reef areas, generally during late spring or early summer. During the mating process, males deposit a sticky fluid containing sperm onto the female’s abdomen; this fertilizes the eggs upon release (Herrnkind et al. undated; Bliss 1982). Fertilized eggs remain under the female’s tail until they hatch, and clutch size varies with location and fishing pressure. In the Dry Tortugas sanctuary, for example, lobsters became reproductively active at larger sizes, and the average number of eggs is higher than in a south Florida fishery (Bertelsen and Matthews 2001). Eggs hatch into phyllosome larvae that drift offshore with the surface currents. This pelagic stage generally lasts 6-12 months, resulting in long distance dispersal spanning hundreds of miles (Herrnkind et al. undated). They next molt into free-swimming transparent puerulus postlarvae, which leave the open ocean to settle in nearshore vegetated benthic areas such as sea grasses, algal beds, or mangroves (Acosta et al. 1997; Butler et al. 1997). This process is thought to vary with characteristics of the nursery habitat, postlarval supply, environmental factors, fishing pressure, and oceanographic circulation (Butler et al. 2001; 1997; Cruz et al. 2001; Yeung et al. 2001). These organisms metamorphose into juveniles, whose movements are asocial and initially restricted to sheltered areas such as algal beds (Butler et al. 1997, Herrnkind et al. undated). As time goes on they become increasingly vagile and social, living in small aggregations inside crevices, under rocks, seaweeds, sponges and corals. As lobsters approach maturity, which may occur around 2-3 years of age, they move to deeper waters in coral reef systems where reproduction occurs (Herrnkind et al. undated). 
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LEVEL I. - Starting Up

A.  Download the Simulation

1) You can obtain a copy of the simulation from the NCEP web-site:

· http://ncep.whirl-i-gig.com/marine_simulation/sim.html
2) Download and unzip.  Two folders will be visible:  one for PC and one for MAC.
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3) To run the simulation, you will need to have Java version 1.4 or later

on your computer. This is available for download free of charge at http://java.sun.com/j2se/1.5.0/download.jsp. Please note that if you are working on a Macintosh computer, the version of Java used should be 1.4.2.

4) Download the exercise onto your computer by clicking on the file or simulation icon. Note: to run the simulation, you will need to have a recent version of the Java Runtime Environment on your computer, available for free download at http://java.sun.com/j2se/1.5.0/download.jsp. If your operating system is MacOSX, click on the Apple icon on the upper left part of your screen.  Then click on “Software Update”. If no Java Runtime Environment update is required, quit Software Update and proceed.

5) Save the program to your directory of choice. 

B.  Start the Interactive Simulation

1) Double-click on the simulation icon to start the exercise. 

2) After a few seconds, a window will appear. This includes a satellite image, as well as several variables describing fishery biology and economics, and simulation General parameters (see Glossary).

3) There are three species-types to choose from. These are Grouper, Conch, and Lobster. Their characteristics are based on those of real organisms.

4) Each variable (for example: lifespan) is set to default values that are within ranges published in the literature for the focal species, when these are known (Table 1). It is important to note that the exercise simulates “species types” and their fisheries. As such, the simulated organisms and their fisheries, although generally similar to grouper, conch, and spiny lobsters, are not intended to represent real world situations. To simulate other organisms of your choice, you can alter these numbers by selecting them and typing in your own values. 

	 
	Grouper
	Conch
	Lobster

	Initial population
	150,000
	500,000
	200,000

	Lifespan (days)
	3285
	3102
	2920

	Intrinsic growth rate 
	0.2
	0.4
	0.5

	Carrying capacity 
	10000
	15000
	12500

	Avg. catch weight (kg)
	5
	0.4
	1

	Dispersal rate 
	8
	1
	6

	Fishing efficiency 
	0.02
	0.09
	0.04

	Speed (km/hr)
	20
	20
	20

	Travel cost ($/km )
	1
	1
	1

	Boat cost ($/day )
	12
	12
	12

	Max. boats/port
	35
	35
	35

	Maximum harvest (kg)
	200
	 40
	 100

	Price ($/kg)
	5
	6
	8


Table 1.  Summary of default values employed in the simulation exercise.

5) Pointing at each parameter with your cursor causes tool tips to appear. These explain each parameter, and provide minimum and maximum values. Parameters are also described in the Glossary. Please note: these tool tips will only appear if your mouse is rolled over the value legend (such as “Initial population” or “Lifespan (days)”. The tool tips will not appear if the mouse is rolled over the value field, or boxes where the variables are set.

6) You will see that the base image is overlaid by a hexagonal grid. In conservation planning, landscapes or seascapes are often subdivided into such units for planning purposes.

7) The red dots in each hexagon reflect the relative abundance of adult organisms within each planning unit. Pointing at a planning unit with your cursor will cause the number of organisms present in the hexagon, as well as the habitat type (see below), to appear. 

8) Later on in the exercise, you will be able to construct a reserve system by clicking on hexagonal planning units of your choice. This will cause the hexagon to become outlined in white. No fishing will occur in protected hexagons, although boats may transit through without fishing.

9) You will also be able to follow boat movements along the seascape. Boats belong to one of two ports (Yellow or Blue), and are represented by small dots of the corresponding colors. 

10) Pressing the Run button will start the simulation. 

11) You may interrupt the run by pressing the Stop button. The speed of the simulation can also be changed in the appropriate field. Please note that 100 is the maximum available speed (as noted in the tool tips). There are additional buttons to speed up the simulation by the chosen time period (for example, “+1 decade”). 

12) While the simulation is running, the base image will depict changes in numbers of adults through corresponding alterations in size of the red dots.  

13) Changes in population numbers (total and within reserves), as well as economic aspects of the fishery are shown in 4 graphs. Please note that the scale of the graphs changes as the data warrant. Clicking on a graph will cause a larger version to appear in a separate window. The graphs can also be saved using the “Save” option in the “File” menu. 

14) Boats exit the simulation if their profits are negative, so that boat numbers may vary throughout the run. This simulation assumes there will be at least one boat from each port participating in the fishery, even at negative profits. The model for the behavior of fishermen is that if all boats from a given port have negative profit one day, then one boat drops out of service.  One or more boats can be making a profit, even while the average profit (shown in the graphs) is negative.  Thus, the average profit can go negative for a while, before boats start dropping out of service, and more than one boat may be present even at negative profits.  

15) The percentage of total area in reserves at any given time is shown on the bottom right of the panel, as are the number of days simulated. Both are highlighted in red.

16) The simulation will end automatically when either the maximum days simulated or the minimum population size are reached. The default value for maximum days simulated is 20 years (7300 days). These variables can be specified in the column headed “General Parameters” on the right hand side of the panel. 

17) You may alter the base image of the simulation using the “Base image of display” button on the bottom right. Toggle between a satellite image, an image showing habitat classifications, and an image reflecting habitat suitability for each species type. Species occurrence in each kind of habitat is based on their biology. Sea grass is appropriate habitat for conch, for example, while coral reefs are more suitable for spiny lobsters and groupers. Pointing your cursor at any hexagon will cause these classifications to appear. In the suitability screen, the most suitable habitats are lighter in color.  The habitats, classified as follows, are defined in the 
Glossary:  

· Unclassified (land or deep water)

· Sparse seagrass

· Medium density seagrass

· Dense seagrass

· Sand

· Silt / mud

· Batophora dominated

· Sargassum on hardbottom

· Dead coral and Microdictyon
· Sparse gorgonians and algae

· Uncolonized pavement and sparse gorgonians

· Montastraea reef

· Acropora palmata reef

· Porites reef

· Patch reef

· Mangrove

18) The “Base image of display” menu also contains options that summarize the following simulation outputs: Average Effort, Average Harvest, and Potential Blue or Yellow boat profits. Values corresponding to each cell are provided in the tool tips. The Average Effort and Average Harvest options output the average effort and catch over the last year of the simulation. The Potential Profit displays reveal the projected profits for each color boat at the time. The lighter colors indicate larger amounts, and the values corresponding to each cell are provided in the tool tips. 

19) You can save your results by opening the File menu under the Save option, on the upper right hand side of the screen. 

20) You will be able to Reset to Time 0, Clear reserves, or Reset default values by selecting these options under the Edit menu, on the upper left side of the screen.

NOTE:  Although efforts have been made to provide a realistic scenario, due to necessary simplifications and assumptions, simulation results are not intended to reflect reality. 

C.  Read the Glossary – Become familiar with the terminology.  DO NOT MEMORIZE.
Acropora palmata reef. Habitat classification. Reefs with the coral Acropora palmata, also called Elkhorn Coral, typically have high vertical relief. This habitat is found at the crest of the reef. Although A. palmata is generally the most common coral in this habitat, the bottom community also includes other stony corals, gorgonians, and algae. This habitat is found between approximately 1 and 5 meters deep. 

Average catch weight (kg.). Simulation fish parameter. Average weight of fish caught (kg; 0.1 -1000.0).

Base image of display. Simulation general parameter. Image that is used for the background of the simulation. 

Batophora dominated. Habitat classification. This habitat contains abundant patches of the club-like algae Batophora and is typically on a hard bottom with a small amount of sediment. This kind of algae is also often seen growing on conch shells. Other algae and some patches of seagrass are often present in this habitat, which is founding low energy lagoonal environments.

Boat cost ($/day). Simulation boat parameter. Cost per day to operate a boat, excluding travel (0 - 1000). 

Carrying capacity. Simulation fish parameter. Maximum population per hexagon, in optimal conditions (0 – 100,000).

Dead coral and Microdictyon. Habitat classification. In some areas, the majority of corals have died, possibly during bleaching events. These habitats are in shallow waters and appear to have been similar to Montastraea reef communities. They still have the rough structure of a coral rich area. The mesh-like algae Microdictyon is seasonally common and covers the substrate, presumably flourishing after the loss of live coral colonies. This habitat is found in a limited number of areas just landward of the reef crest. 

Dense seagrass. Habitat classification. This habitat is dominated by the seagrass Thalassia, also called Turtle Grass, but may contain the tube-like seagrass Syringodium. Dense Seagrass habitats have high biomass (tall plants, high density) and a low amount of visible sand and silt. This habitat is found in lagoonal environments where sediment is deep enough for the seagrasses to take root.

Dispersal rate. Simulation fish parameter. Percent of fish that move to another cell per day (0.0 – 75.0). 

Fishing efficiency. Simulation boat parameter. Fraction of a cell’s fish that a boat can catch per day (0.0 – 1.0).

Initial population. Simulation fish parameter. Initial total fish population (0 - 10,000,000). For purposes of the simulation, some of the default values may be more representative of well-established and protected areas than initially unprotected systems. These can be changed at will. 

Intrinsic growth rate. Simulation fish parameter. Population growth rate per year, in optimal conditions (0.0 - 2.0). 

Lifespan. Simulation fish parameter. Typical lifespan (days; 0 - 100,000).

Mangrove. Habitat classification. Mangrove trees grow in shallow, brackish waters along coasts and up creeks of some islands. Their roots provide nursery habitat for many important fish species. Mangroves in and around estuaries also trap sediments that might otherwise flow onto reefs and smother corals to death. 

Maximum boats per port. Simulation boat parameter. Maximum number of boats per port (0 – 1000). 

Maximum days simulated. Simulation general parameter. Stop simulation after this number of days (1 – 1,000,000). 

Maximum harvest (kg). Simulation boat parameter. Maximum catch per day (kg; 0 – 10,000). 

Medium density seagrass. Habitat classification. This habitat is dominated by the seagrass Thalassia, also called Turtle Grass, but may contain the tube-like seagrass Syringodium and the thin-bladed seagrass Halodule. Occasionally one also finds small coral colonies within the seagrass. Medium Density Seagrass habitats have medium biomass (medium plant height, medium density) and a medium amount of substratum is visible, when compared to Dense and Sparse Seagrass. This habitat is found in lagoonal environments.

Minimum population size. Simulation general parameter. Stop simulation if fish population drops below this number (0 – 10,000,000). 

Montastraea reef. Habitat classification. The coral species Montastraea annularis, also called Boulder Star Coral, is the dominant coral species in this habitat. This benthic community is diverse, including corals, sponges, gorgonians, and algae. Montastraea Reef also supports a diverse and abundant fish community. This habitat is found in some reef environments between approximately 5 and 15 meters deep. 

Patch reef. Habitat classification. Patch reefs are reef formations often found in lagoons and surrounded by seagrass beds. They commonly have a small ‘halo’ around them of relatively clear sand cleaned by grazing fish and invertebrates. They support much more diverse invertebrate and fish communities than surrounding habitats.

Porites reef. Habitat classification. At some sites, there are unusual areas of extensive growth of the Finger Coral Porites porites. These areas typically support an abundant number of juvenile fish, particularly grunts, parrotfish, wrasse, and damselfish. These reefs are found in shallow water less than 2 meters deep. 

Price ($/kg). Simulation boat parameter. Price per kilogram received by fishermen (0.0 – 100.0). 

Sand. Habitat classification. This habitat includes both clean sand and sand with a sparse algal community. It is found in lagoonal areas and near reefs. 

Sargassum on hardbottom. Habitat classification. This habitat contains numerous Sargassum plants, typically on a hardbottom with a limited covering of sediment. In some areas, the Sargassum plants reach greater than 1 meter tall. Other algae often occur between the Sargassum plants. This habitat occurs in medium energy lagoonal environments.

Silt / mud. Habitat classification. Silt, which is finer than sand, is often present near shore areas and creeks. Seagrass and algae are often present in this shallow water habitat.

Simulation speed. Simulation general parameter. Number of days simulated per second of animation (1 - 100). 

Sparse gorgonians and algae. Habitat classification. Gorgonians include sea fans, sea feather plumes, sea whips, and sea rods. This habitat is composed of sparse gorgonians on a hardbottom with some algae. In some areas, this benthic community is found in shallow reef environments and on hardbottom in the lagoon area.

Sparse seagrass. Habitat classification. This habitat is dominated by the seagrass Thalassia, also called Turtle Grass, but may contain the tube-like seagrass Syringodium and the thin-bladed seagrass Halodule. Occasionally one also finds small coral colonies within the seagrass. Sparse Seagrass habitats have relatively low biomass (short plants, low density) and a high amount of substratum is visible. This habitat is found in lagoonal environments where sediment is deep enough for the seagrasses to take root.

Speed (km/hr). Simulation boat parameter. Speed of travel to fishing grounds (km/hr; 0 – 100). 

Travel cost ($/day). Cost per day to operate a boat to and from fishing grounds (0 - 1000). 

Uncolonized pavement and sparse gorgonians. Habitat classification. Uncolonized Pavement is found in one of the high energy ‘cuts’ through the Acropora reef crest. This habitat is similar to the Sparse Gorgonians and Algae habitat but it has very few gorgonians and algae.

D. Exercise – First Scenario:  
Objectives:  To learn the software interface and the tools.  

In this simulation exercise, you will be able to explore various factors that influence fish population viability and fishery sustainability. You will also experiment with the use of marine reserves as tools in fisheries management. 

Discussion questions for all levels

As you complete each level, think about the major lessons you have learned, regarding marine populations, fishery management, and marine reserves. The simulations provide a useful heuristic tool for exploring many issues in marine reserve design, and are highly illustrative and useful for comparative and educational purposes.  Even so, it is important to consider the limitations of the exercise. The simulation is based on a mathematical model describing organismal population dynamics and fishery economics. The main parameters of this model are the variables on the simulation panel. This model was written by Steven Phillips. The author himself, however, is the first to note that there are limitations to any model, which must be kept in mind when interpreting results. This model focuses mainly on the adult life stage. 

Can you think of some important caveats, and reasons why, although theoretically useful, the results of this exercise cannot be applied directly to any specific area or species? It might be helpful to read over the introductory pages, as they contain relevant information on complexities in life cycles and fisheries of Nassau Grouper, Spiny Lobster, and Queen Conch. 

LEVEL I. Starting Up

Take a few minutes to familiarize yourself with the exercise, and to become comfortable with the simulation. This part of the exercise focuses on an unprotected system, where there are no reserves in place. 

· Make sure that no part of the total area is protected in reserves, by selecting “Clear Reserves” under the “Edit” menu before you begin. 

· Select any species-type.  

· Press Run. The simulation will automatically run for 20 years.

When the simulation has ended, indicate the option/s that best describe/s overall trends observed.  Click on the relevant graph to visualize trajectories over the course of the simulation. A new window will open up.  

You can save output images (as png files) and output data (as text files) using the menu bar:  File > Save
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